


















FLOW CHART – Review Rights 

30364453 

Defence FOI 623/23/24 
Document 7







UNCLASSIFIED

Document search list / check list 
Completion of the document checklist shows that Defence is taking a consistent approach when searching 

for documents. It is particularly important if a matter goes to an external review with the Information 
Commissioner as it acts as a contemporaneous record of the searches that were undertaken. 

 or N/A
Identify other departmental areas; retrieve documents from relevant departmental area(s) 

Search databases 
Objective (seek assistance from Defence Archives if necessary) 

PMKeys 

Sentinel 

Sharepoint 

DPAWS / PDMS / DPSMS (IG and ADFIS) 

AIMS 

Any other relevant database in your area 

Search hard copies 
Retrieve hard copy files from Defence Archives 

Retrieve hard copy files from National Archives of Australia (NAA) 

Search desks / drawers / cabinets / safes / vaults 

Examine old manual document registers / personal diaries / notes etc… 

Contact relevant staff (past/present) – obtain written response as evidence (if required) 

Search other electronic records 
Personal / Group emails (inboxes, sent, deleted, archived) 

Personal folders, mobile phones, text messages, Lync, Skype 

Any additional searches (please identify) 

For ALL searches (even if documents found) please provide pdf screenshots of the searches conducted 

Searches 
conducted by: 

Time taken to conduct 
searches (in hours): 

[Convert this document to PDF, insert electronic signature and email to your FOI case manager] 
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From: FOI Case Management
Subject: For Action: FOI Inquiry XXX - Advice on Scope - Due Midday/COB DAY XXX 

MONTH 20XX

Dear [recipient] 

Action required by COB/midday <day of the week> [date] 

1. Review the scope and advise if the request can be actioned in its current form.

2. If the scope cannot be actioned in its current form, please advise why and provide suggested
revisions that could be made to the applicants scope.

3. Advise of other business areas that may hold documents or have an equity in this request.

Defence has received a request under the Freedom of Information Act 1982 (FOI Act) from [applicant] on 
<DD Month YYYY> for: 

“[request]”. 

Your area has been identified as potentially holding documents relevant to the scope of the request. 

This is not a tasking to undertake document searches. Once your response is received or if we do not 
receive a response by the due date, a formal tasking will be sent. 

Regards 

<First name> 
Freedom of Information Team  
Media and Information Disclosure Branch  
Ministerial & Executive Coordination and Communication Division 
Department of Defence 

Freedom of information requests | About | Defence 
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From: FOI Case Management
Subject: FOR ACTION:  FOI Tasking - FOI xxx/YY/YY 

Dear [recipient] 

This is a formal tasking relating to a request made on [date] by [applicant] under the Freedom of Information Act 
1982 (FOI Act) for: 

[request]. 

Talking Points will be required as this FOI request has been classified as ‘Media/Sensitive’.  

Action required 

Phase 1: Identify the documents and appoint an Accredited Decision Maker (ADM) – due by [date] 
1. Notify who has been appointed as the ADM and if the documents can be released administratively outside

the FOI Act.
2. Send the following:

 Digitally signed Document Search Checklist with screenshots.
 In‐scope documents with no redactions in PDF format.

Note: For DSN documents, please email on the DPN when DSN documents provided.
 Draft Schedule of Documents (SOD) if there are five or more documents.

Phase 2: Draft documents – due by [date] 
Prepare and send: 

1. Statement of Reasons (SOR) (SOR Guidance) as a word document (unsigned).
2. Draft in scope documents – combined into one single PDF document with proposed redactions unapplied ‐

marked with relevant exemption codes using the FOI redaction tool in PDF.
3. Schedule of Documents (SOD), in word format if applicable.
4. Prepare draft ‘Talking Points’ in Word Format – email relevant Strategic Communications adviser for

clearance.
FOI Directorate (FOID) will review the draft decision package and provide feedback to the ADM and/or FOI Co‐ord. 

Phase 3: Final documents – due by [date] 
Please discuss feedback provided on the draft decision package with the FOID, then prepare and send the final 
decision package: 

1. SOR electronically signed by the ADM.
2. Documents in the form approved for release in PDF format with redactions applied.
3. SOD in PDF format.
4. Final, cleared Talking Points in PDF format – SES Band 2/2 Star clearance.

Consultation 

Please consider/identify third party consultations early so that statutory time limits can be managed. The ADM is 
required to authorise these consultations and approve documents for release to any third parties which the FOI 
team will then coordinate. Extra time is provided when third party consultation is required. 

If the ADM considers there is a requirement to liaise with the offices of the Minister, Secretary, CDF or VCDF, please 
advise as soon as possible which the FOI team will facilitate.  

Timeframes 
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Under the FOI Act, Defence has 30 calendar days to provide a decision and documents to the applicant. Documents 
and draft decisions must be reviewed by FOID before they can be signed by the ADM. Failure to provide the 
documents to FOID and appoint an ADM in a timely manner will impact on the time the ADM has available to make 
their decision within the legislated timeframe.  
 
Templates and examples 

Please click here to access the ADM Reference Guide. If you require assistance with drafting the SOR please contact 
me and I can provide sample wording to consider.  
 
FOI Case Manager 

I am the Case Manager for this request and am here to help you process this request. Please contact me early to 
discuss any questions or concerns.  
 
Kind regards, 
 
<SIGNATURE BLOCK> 
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From: FOI Case Management
Subject: FOR ACTION:  FOI Tasking - FOI xxx/YY/YY 

Dear [recipient] 

This is a formal tasking relating to a request made on [date] by [applicant] under the Freedom of 
Information Act 1982 (FOI Act) for: 

“[request]”. 

This FOI request has been identified as a routine request. Please advise of any sensitivities or 
media/parliamentary attention in relation to this topic.  

Action required 

Phase 1: Identify the documents and appoint an Accredited Decision Maker (ADM) – due by [date] 
1. Notify who has been appointed as the ADM. Alternatively, let us know if the documents can be

released administratively outside the FOI Act.
2. Send the following:

 Digitally signed Document Search Checklist with screenshots.
 In‐scope documents with no redactions in PDF format.

Note: For DSN documents, please email on the DPN when DSN documents provided.
 Draft Schedule of Documents (SOD) if there are five or more documents.

Phase 2: Draft decision package – due by [date] 
Prepare and send the draft: 

1. Statement of Reasons (SOR) as a word document (unsigned) (for guidance see Statement of
Reasons Guidance Notes).

2. In‐scope documents, combined into one single PDF document, with proposed redactions unapplied
but marked with relevant exemption codes using the FOI redaction tool.

3. Schedule of Documents (SOD) in word format (if applicable).

The FOI Directorate (FOID) will review the draft decision package and provide feedback to the ADM and/or 
FOI Co‐ord. 

Phase 3: Final decision package – due by [date] 
Please discuss any feedback provided on the draft decision package with the Case Manager, then prepare 
and send the final decision package in PDF format: 

1. SOR digitally signed by the ADM.
2. Documents in the form approved for release with redactions applied.
3. SOD (if applicable).

Consultation 

Please consider/identify consultations early so that statutory time limits can be managed. The FOID will 
coordinate any consultation.  

Timeframes 
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Under the FOI Act, Defence has 30 calendar days to provide a decision and documents to the applicant. 
Documents and draft decisions must be reviewed by the FOID before they can be signed by the ADM. 
Failure to complete phase 1 by the due date will impact on the time the ADM has available to make their 
decision within the legislated timeframe.  
 
Additional guidance 

Please click here to access the ADM Reference Guide. If you require assistance with drafting the SOR 
please contact me and I can provide sample wording to consider.  
 
FOI Case Manager 

I am the Case Manager for this request and am here to help you process this request. Please contact me 
early to discuss any questions or concerns.  
 
Regards 
 
<SIGNATURE BLOCK> 
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From: FOI Case Management
Subject: FOR ACTION:  FOI Tasking - FOI xxx/YY/YY 

Dear [recipient] 

This is a formal tasking relating to a request made on <DD Month YYYY>, by <applicant name> to amend/annotate 
their personal record maintained by Defence under section 48 of the Freedom of Information Act 1982 (FOI Act). The 
applicant has requested their personal record be amended/annotated to include the following details: 

“[insert requested amendments/annotations]” 

Action required 

Phase 1: Prepare draft decision and appoint an Accredited Decision Maker (ADM) – due by [date] 
1. Acknowledge receipt of this request.
2. Appoint an Accredited Decision Maker (ADM) and advise the FOI Case Manager.
3. Review relevant evidence and determine if requested amendment / annotation is appropriate.
4. Prepare and send the draft Statement of Reasons (SOR) as a word document (unsigned) to the FOI

Case Manager:

The FOI Directorate (FOID) will review the draft decision package and provide feedback to the ADM and/or 
FOI Co‐ord. 

Phase 2: Final decision package – due by [date] 
Please discuss any feedback provided on the draft decision package with the Case Manager, then prepare 
and send the final decision package in PDF format: 

1. SOR digitally signed by the ADM.
2. Documents in the form approved for release (if required).

Timeframes 

Under the FOI Act, Defence has 30 calendar days to provide a documents to the applicant. Documents and 
draft decision must be reviewed by the FOID before they can be signed by the ADM. 

Additional guidance 

Please click here to access the ADM Reference Guide. If you require assistance with drafting the SOR 
please contact me and I can provide sample wording to consider.  

FOI Case Manager 

I am the Case Manager for this request and am here to help you process this request. Please contact me 
early to discuss any questions or concerns.  

Regards 

<SIGNATURE BLOCK> 
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Defending Australia and its National Interests 

 

DEFENCE FOI 319/21/22 STATEMENT OF REASONS UNDER THE FREEDOM OF 
INFORMATION ACT 
 

1. I refer to the application by  under the 
Freedom of Information Act 1982 (FOI Act) for access to: 

 
FOI decision maker 
2. I am the authorised officer pursuant to section 23 of the FOI Act to make a decision on 
this FOI request. 

Documents identified 
3. I identified eight documents as matching the description of the request.  

4. The decision in relation to each document is detailed in a schedule of documents.  

5. I have added an FOI reference number and Item/Serial number to each of the 
documents, which corresponds with the schedule. 

Exclusions 
6. Personal email addresses, signatures, employee numbers and mobile telephone numbers 
contained in documents that fall within the scope of the FOI request, duplicates of documents, 
and documents sent to or from the applicant are excluded from this request. Defence has only 
considered final versions of documents. 

Decision 
7. I have decided to: 

a. release five documents in full; 

b. partially release three documents in accordance with section 22 [access to 
edited copies with exempt or irrelevant matter deleted] of the FOI Act, on the 
grounds that the deleted material is considered exempt under section 47E(d) 
[public interest conditional exemptions-certain operations of agency], 47F 
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[public interest conditional exemptions-personal privacy] and 47G [public 
interest conditional exemptions-business] of the FOI Act; and 

c. remove irrelevant material as referred to in the scope of the request in 
accordance with section 22(1)(b)(ii) of the FOI Act. 

Material taken into account 
8. In making my decision, I had regard to: 

a. the terms of the request; 

b. the content of the identified documents in issue; 

c. relevant provisions in the FOI Act;  

d. the Guidelines published by the Office of the Australian Information 
Commissioner under section 93A of the FOI Act (the Guidelines); and 

e. consultation with third parties. 

 
Reasons for decision  

Section 22 – Edited copies with exempt or irrelevant matter deleted 
 
9. Section 22 of the FOI Act provides that if an agency or Minister decides: 

 
(i) to refuse access to an exempt document; or 
(ii) that to give access to a document would disclose information that would 

reasonably be regarded as irrelevant to the request for access  
 
and it is reasonably practicable to prepare a copy of the document modified by deletions, the 
agency or Minister must give the applicant access to the edited copy. 

10. Considering all of the above, I decided that it was reasonably practicable to remove the 
material that did not fall within scope of this request and release the documents in that form. 

Section 47E – Certain operations of agencies 
11. Section 47E(d) of the FOI Act states: 

 
A document is conditionally exempt if its disclosure under this Act would, or could 
reasonably be expected to, do any of the following: … 
 
(d) have a substantial adverse effect on the proper and efficient conduct of the 
operations of an agency..  

12. Upon examination of the documents, I found information that relates specifically to 
names and ADF roles which are not publicly available information. If this information was to 
be made public, it could reasonably impact the ability of the individual to undertake their role 
and have an adverse effect on the proper and efficient conduct of the operations of the 
Department. 

13. Section 11A(5) of the FOI Act requires an agency to allow access to an exempt 
document unless, in the circumstances, access to the document would, on balance, be contrary 
to the public interest. My public interest considerations are set out below. 
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Section 47F - Personal privacy 
14. On review of the documents, I identified information, specifically personal information
of third parties other than the applicant, such as names, rank and personal details. I found the
material to be conditionally exempt under section 47F of the FOI Act.

15. When assessing whether the disclosure of this personal information is unreasonable, I
considered the following factors:

a. the extent to which the information is well known;
b. whether the person to whom the information relates is known to be (or to have

been) associated with the matters dealt with in the document;
c. the availability of the information from publicly accessible sources;
d. any other matters that the agency or Minister considers relevant.

16. Against the above criteria I found:

a. that the specific personal information is not well known;
b. the individuals whose personal information is contained in the document is not

known to be associated with the matters dealt with in the documents; and
c. the information is not readily available from publicly accessible sources.

17. Taking into account the above factors, I consider the release of the material would be an
unreasonable disclosure of personal information of individuals and could reasonably be
expected to cause harm to their privacy. I have therefore decided that this information is
conditionally exempt under section 47F of the FOI Act.

18. Section 11A(5) of the FOI Act requires an agency to allow access to an exempt
document unless, in the circumstances, access to the document would, on balance, be contrary
to the public interest. My public interest considerations are set out below.

Section 47G  - Business 
19. Upon examination of the documents, I identified that they contained details relating to
third party business information which is no longer relevant in respect of this request. I found
the material to be conditionally exempt under section 47G of the FOI Act which states:

1) A document is conditionally exempt if its disclosure under this Act would
disclose information concerning a person in respect of his or her business or
professional affairs or concerning the business, commercial or financial affairs of
an organisation or undertaking, in a case in which the disclosure of the
information:

(a) would, or could reasonably be expected to, unreasonably affect that
person adversely in respect of his or her lawful business or professional
affairs or that organisation or undertaking in respect of its lawful business,
commercial or financial affairs;

20. I consulted with third parties regarding their business information which was contained
within the documents. The third parties have objected to the release of their business details
due to changes to business ownership and staffing.

21. While I consider that release of the material removed under sections 47G may be of
some interest to the applicant, disclosure of the conditionally exempt material would not
provide any meaningful information now that the business has changed hands, and the new
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owners are concerned that releasing the information could reasonably adversely impact their 
business affairs. I agree with their objections. 

22. Removal of the conditionally exempt information, does not significantly impact the 
relevance of the information held within the document as per the scope of the request. 

23. Considering the above, I decided that release of this information would be unreasonable 
disclosure of their business information and I consider the material is conditionally exempt 
under section 47G of the FOI Act.  

24. Section 11A(5) of the FOI Act requires an agency to allow access to an exempt 
document unless, in the circumstances, access to the document would, on balance, be contrary 
to the public interest. My public interest considerations are set out below. 
 
Sections 47E(d), 47F and 47G - Public interest considerations  
25.  In assessing whether disclosure is on balance, contrary to the public interest, I 
considered the Guidelines together with a range of factors set out in section 11B(3) of the FOI 
Act, which favours access to a document: 
 

a) promote the objects of this Act (including all the matters set out in sections 3 
and 3A); 

b) inform debate on a matter of public importance; 
c) promote effective oversight of public expenditure; 
d) allow a person to access his or her own personal information. 

26. I note that disclosure of the requested documents may promote some of the objects of 
the FOI Act, as information held by the Government is a national resource. However, 
disclosure of the specific conditionally exempt material would not increase public 
participation in the Defence process, nor would it increase scrutiny or discussion of Defence 
activities. 
 
27. Paragraph 6.22 of the Guidelines specifies a non-exhaustive list of public interest 
factors against disclosure. The factors I find particularly relevant to this request are that 
release of this information could reasonably be expected to prejudice or harm: 
 

a. the protection of an individual’s right to privacy; 
b. the interests of an individual or group of individuals; 
c. an agency’s ability to obtain confidential information; 
d. an agency’s ability to obtain similar information in the future; and 
e. the management function of an agency. 

 
28.  I consider the release of the material removed under sections 47E(d), 47F and 47G may 
be of some interest to the applicant, however disclosure of the conditionally exempt material 
would not inform public debate on any matter of public importance in any meaningful way. 
Additionally, I do not consider that disclosure of the material would promote oversight of 
public expenditure. 
 
29.  While I accept there is a public interest in ensuring that Defence undertakes its 
functions in a transparent and proper manner, there is also a strong public interest in 
maintaining the confidentiality of material contained in the documents. In my view, it would 
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Schedule of Documents – Defence FOI XXX/XX/XX 

 1 

Item Document Date Document description or title Pages  Decision  Reason for decision under the Act 

1 1 1/6/2019 Email: Record of conversation 

 

Partial access 

Deletions made in accordance with section 22 of the FOI 
Act, on the grounds that the deleted material is exempt 
under section 47F of the FOI Act. 
 

 2 11/7/2019 Statement  Full access Deletions made in accordance with section 22 of the FOI 
Act, on the grounds that the deleted material is irrelevant. 

2 1 12/7/2019 Email: Further detail  Deny access Document is exempt under sections 47F and 47E(c) of the 
FOI Act. 

 2 13/7/2019 Ministerial submission 91-20135 

 

Partial access 

Deletions made in accordance with section 22 of the FOI 
Act, on the grounds that the deleted material is exempt 
under section 33(a)(iii), and section 47E(d) of the FOI 
Act. 
 

3 1 11/7/2019 Report  Full access  

4 1 01/03/2021 Brief  Full access Deletions made in accordance with section 22 of the FOI 
Act on the grounds that the deleted material is irrelevant. 

 
Titles explained – DELETE AFTER COMPLETED  
Item – relates to each item within the scope of the request. *Optional as not all scopes will have separate items. 
Document – relates to the document number assigned to the in scope document  
Date – this is the date the document was created/signed. *Documents should be listed in chronological order  
Document description or title – Keep it simple. It should be enough information for the applicant to understand what type of document it is 
Pages – Number of pages in the document. *Optional for final version, but it can assist when preparing large document packs. 
Decision – Simple reason for decision made on the document. *Full access, partial access, access denied.   
Reasons for decision under the Act – Outlines what exemptions codes have been used on the document. 
 
Note: A Schedule of Documents is only required where there are five or more documents identified.  
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ADM Reference Guide 

 

 

 

 

 
 

Table of contents 

Phase 1: identify the in-scope documents ...................................................................................................................... 2 

1. How to organise the in-scope documents ................................................................................................................ 2 

2. How to convert/print a document to Adobe PDF ..................................................................................................... 2 

3. Phase 1 checklist ....................................................................................................................................................... 3 

Phase 2: prepare the draft decision package .................................................................................................................. 3 

1. How to prepare the draft decision package ............................................................................................................. 3 

2. How to use the Redaction Tool ................................................................................................................................. 4 

3. How to add the FOI Header ...................................................................................................................................... 6 

4. Phase 2 checklist ....................................................................................................................................................... 7 

Phase 3: finalise the decision package ............................................................................................................................ 8 

1. Phase 3 checklist ....................................................................................................................................................... 8 

2. How to apply your digital signature in Adobe .......................................................................................................... 8 

Annexure 1: Template wording where whole pages have been removed .................................................................. 10 

 

  

Overview 
• This guide has been prepared by the FOI Case Management team to assist Accredited Decision Makers 

(ADM) to effectively complete each phase of a formal FOI tasking 
 

• All completed tasks should be sent to the FOI Case Management inbox: 
foi.casemanagement@defence.gov.au 
 

• Please contact the Case Manager if you require assistance 
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Phase 1: identify the in-scope documents 

1. How to organise the in-scope documents

Where documents have been located by the line area, consider reviewing and organising the documents using this 
suggested process before sending to the Case Manager by the due date:  

1 Save the document(s) from the line area to your H drive 

2 Open the first document 

3 Review the document to: 

1. confirm it is within scope of the request
2. ensure attachments are included
3. determine whether it should be removed on the basis of an exclusion. This might be the case if:

a. it is a draft
b. it is a duplicate of another document identified to be in-scope (for example, it is an email that is

in a subsequent email thread)
c. it was previously sent to or from the applicant

If the document passes the review, proceed to step 4 

4 Convert/print the document to PDF if it is not in PDF format. You will need to ‘print to PDF’ PDF documents 
that have been digitally signed before any redactions can be applied 
See section 2 ‘How to print/convert a document to Adobe PDF’ or watch the video ‘How to convert a 
document to PDF’ on the FOI intranet page  

5 Order the document chronologically by including the date of the document at the beginning of the file name 
in the format YYYYMMDD. If there are multiple documents of the same date, you can use the format 
YYYYMMDD(X). For example: ‘20170904(1)’ followed by ‘20170904(2)’ 

6 Repeat steps 1 – 5 for each document 

7 Number the documents and also list them in order in the Schedule of Documents (SOD) if there are 5 or 
more documents 

2. How to convert/print a document to Adobe PDF

1 Click: File > Save as Adobe PDF > Save 

2 Click: File > Print > Printer: Adobe PDF > Print > Save 

Note: if you are converting an email to PDF using this method, your name will appear on the document. 
This can be redacted during phase 2 under s22 
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• set out your reasons for applying each exemption

• address all relevant legislative provisions and the Freedom of Information Guidelines

2. How to use the Redaction Tool

Use the Redaction Tool to prepare an edited copy of a document which contains irrelevant or exempt information: 

1 Open the document in Adobe Pro 

2 Select: More Tools > Redact 

3 Select Redact Text & Images 

If you do not have this option, select: Mark 
for Redaction > Text & Images > OK 
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4 Open the Redaction Tool in Adobe Pro  

 
5 Right click on the exemption > select Make 

Current Properties Default 

 
6 Return to the document and redact the 

irrelevant or exempt matter. The redaction 
will be visible if you hover your mouse over 
the redacted text  

 

 

 

 

 

 

 

 

 

 

 

Why use the Redaction Tool? 

 It is easy to use, it is more time efficient, and was created to be very user-friendly 
 The redaction properties are already set so you don’t need to change them  
 There is no need to manually add the exemption to the proposed redacted information  
 The different coloured exemptions make it easy for the Case Manager to determine the exemption 

claimed when reviewing the documents  
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3. How to add the FOI Header  

1 Open the document in Adobe Pro 

 
2 Select Edit PDF 

 
3 Select: Header and Footer > Add 

 
 
 
 
 
 

 
Note: if you receive a message that the file 
already contains a header or footer, select 
‘Add New’ 

 
4 Change the font to: Arial > size 10 > Red  
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Annexure 1: Template wording where whole pages have been removed 

This page and the following XX pages are exempt from 
release under section XX(x) of the FOI Act. 
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The Australian Information Commissioner (IC) finalised an investigation into a complaint relating to 
the Department’s process for conducting personal information consultations under section 27A of 
the Freedom of Information Act 1982 (FOI Act).  

The IC recommended that all staff members be reminded of the importance of the consultation 
process and Defence’s obligation to consider whether a person might reasonably wish to make a 
contention that a document should be exempt on the grounds of personal information under section 
47F of the FOI Act.  

The attached statement details the consultation process under the FOI Act where documents 
capture the personal information of an individual other than the applicant. It outlines both the 
process and the role of accredited decision makers (ADM) and FOI case managers. 

Please familiarise yourself with the statement and seek further guidance from the FOI team if you 
have any questions regarding the consultation process.  

Following the processes outlined below, will ensure that Defence complies with its obligations under 
the FOI Act. It will ensure that all individuals affected by the FOI process have the opportunity to 
have their contentions considered prior to the release of any documents and ensure they 
understand their review rights, in the event that they are not satisfied with the ADM’s decision. 

Section 47F – Personal Information 

Section 47F of the Freedom of Information Act 1982 (FOI Act) conditional exempts documents where 
disclosure would involve the unreasonable disclosure of personal information of any person 
(including deceased persons).  

Personal information  

Personal information is defined in section 6 of the Privacy Act 1988 as: 
information or an opinion about an identified individual, or an individual who is reasonable 
identifiable: 

a. whether the information or opinion is true or not; and
b. whether the information or opinion is recorded in a material form or not.

The Freedom of Information Act 1982 (FOI Act) applies the definition of personal information from 
the Privacy Act. 

Examples of personal information 

For something to be considered personal information it: 

• must be information about an identified person (name them) or an individual who is
reasonably identifiable (give enough information to identify them)

• say something about them
• may be an opinion
• does not need to be true
• may be recorded in a material form or not

Personal information can include a person’s name, address, mobile phone number, signature, date 
of birth, medical record, bank account details, leave history, performance management records and 
taxation information.  

Third Party Consultation
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Section 27A of the FOI Act - Personal information consultations 

Where a document includes personal information relating to a person who is not the FOI applicant, 
the individual should be given a reasonable opportunity to make submissions that their personal 
information in the document should be exempted from disclosure. 

Section 27A of the FOI Act provides: 

(1) This section applies if:
(a) a request is made to an agency or Minister for access to a document containing

personal information about a person (including a person who has died); and
(b) it appears to the agency or Minister that the person or the person’s legal personal

representative (the person concerned) might reasonably wish to make a contention
(the exemption contention) that: 
(i) the document is conditionally exempt under section 47F; and

(ii) access to the document would, on balance, be contrary to the public interest for
the purposes of subsection 11A(5).

Note:       Access must generally be given to a conditionally exempt document 
unless it would be contrary to the public interest (see section 11A). 

(2) In determining, for the purposes of paragraph (1)(b), whether the person concerned might
reasonably wish to make an exemption contention because of personal information in a 
document, the agency or Minister must have regard to the following matters: 
(a) the extent to which the information is well known;
(b) whether the person to whom the information relates is known to be (or to have been)

associated with the matters dealt with in the information;
(c) the availability of the information from publicly accessible sources;
(d) any other matters that the agency or Minister considers relevant.

Opportunity to make submissions 

(3) The agency or Minister must not decide to give the applicant access to the document unless:
(a) the person concerned is given a reasonable opportunity to make submissions in

support of the exemption contention; and
(b) the agency or the Minister has regard to any submissions so made.

(4) However, subsection (3) only applies if it is reasonably practicable for the agency or Minister
to give the person concerned a reasonable opportunity to make submissions in support 
of the exemption contention, having regard to all the circumstances (including the 
application of subsections 15(5) and (6) (time limits for processing requests)). 

Decision to give access 

(5) If the agency or Minister decides to give access to the document, the agency or Minister must
give written notice of the decision to both of the following: 
(a) the person concerned;
(b) the applicant.

Access not to be given until review or appeal opportunities have run out 

(6) However, the agency or Minister must not give the applicant access to the document unless,
after all the opportunities of the person concerned for review or appeal in relation to the 
decision to give access to the document have run out, the decision to give access still 
stands, or is confirmed. 

Note 1:       The decision to give access to the document is subject to internal review (see 
Part VI), review by the Information Commissioner (see Part VII) and review by 
the Tribunal (see Part VIIA). 
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Note 2:       For when all opportunities for review or appeal in relation to the decision to 
give access to the document have run out, see subsection 4(1). 

Notice and stay of decision not to apply unless submission made in support of exemption 
contention 

(7) Subsections (5) and (6) do not apply unless the person concerned makes a submission in
support of the exemption contention as allowed under paragraph (3)(a). 

Edited copies and personal information 

(8) This section applies:
(a) in relation to an edited copy of a document—in the same way as it applies to the

document; and
(b) in relation to a document containing personal information—to the extent to which the

document contains such information.

Generally the starting point is that consultation should occur if an individual’s personal information 
is captured in the documents that fall within scope of the request and it not already in the public 
domain.  

The consultation process 

Roles 

Once personal information has been identified in the documents, the ADM must advise the FOI case 
manager that a consultation under section 27A of the FOI Act is required. The ADM then provides a 
copy of any sections of the documents which contain the individual’s personal information to 
facilitate the consultation process.  

The FOI team is responsible for conducting the consultation process on behalf of ADMs using the 
consultation template.  

The FOI case manager will contact the FOI applicant and confirm if they consent for their name to be 
disclosed for the purpose of consultation. 

The FOI case manager will also add an additional 30 days to the processing period and advise the 
applicant of this change. 

The consultation 

The consultation will occur with: 

• the person (or their legal representative)
• if the person is deceased, their legal representative

Consultation on personal information should take place: 

• where is it is reasonably practicable to do so
• where it appears that the person might reasonably wish to make a submission that their

personal information should not be released
• where a person is specifically named in the scope of an FOI request

However, it may not be reasonably practicable to consult a person where: 
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• there are no contact details for the person
• a large number of people need to be consulted
• the person’s information is not within the scope of the request.

In these circumstances, the ADM should apply section 47F of the FOI Act to the personal 
information, on the grounds that the person has not had the opportunity to object.   

Public servants 

Where a public servant’s name appears in the documents because of their usual duties or 
responsibilities it would not be unreasonable to disclose this unless special circumstances exist. 
Special circumstances may include: 

• work health and safety concerns
• where the scope of the request includes potentially sensitive issues – including an

individual’s disposition or private characteristics, family law, risks of harm
• staffing issues – including staff management / personnel management issue, fact findings.

If special circumstances exist, the individual should have an opportunity to raise their concerns 
either directly to DFOI or through their manager.  

This stance in relation to the release of public servant’s names aligns with the position paper 
published by the Office of the Australian Information Commissioner in August 2020 which provides 
that: 

Agencies and Ministers should start from the position that including the full names of staff in 
documents released in response to FOI request increases transparency and accountability of 
government and is consistent with the objects of the FOI Act. 

Further guidance on the release of public servant names and contact details is available in the 
position paper. 

Defence encourages decision makers to engage with the FOI team and relevant work areas around 
the release of any staff names that appear in identified documents when they are performing their 
official duties. If there are special circumstances, such as a work health or safety reason, this 
information can be considered further by the ADM, with consultation undertaken under section 27A 
of the FOI Act.  

The content of the consultation  

The consultation will cover all the documents that are relevant to the individual. 

The person being consulted should be asked to address: 

• whether they object to the release of information and why
• the extent to which the information is well known
• whether they have been linked to the information
• whether the information is in the public domain
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The name of the FOI applicant cannot be released to the person being consulted, unless the FOI 
applicant has agreed to release their name. Information relating to other third parties should not be 
released to the person being consulted. 

Consultation response 

The ADM must consider the consultation response when deciding whether to release the personal 
information. In the Statement of Reason, the ADM should advise the FOI applicant whether 
consultation with third parties occurred, and identify whether any material facts emerged from the 
consultation that were or not relied on in making their decision. 

Regardless of whether the ADM agrees with the contentions of the person, they must be consulted 
before the documents are released to the applicant. If the ADM does not agree with the contentions 
of the third party, the third party has the opportunity to seek a review of the decision, prior to the 
release of any documents to the FOI applicant.  

More information / questions  

For more information on the consultation process speak to the FOI team. 

The OAIC website contains further information on the consultation process, including flow charts 
that may assist you to better understand the process.  
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What sort of documents should I release 
administratively? 
Stakeholder fact sheet 
Section 15A of the FOI Act provides provisions for persons seeking access to documents containing their 
personal information to first seek them through the Department’s established administrative processes. 
If a member or ex-serving member of the Australian Defence Force or a current or ex-employee of the 
Department of Defence is seeking access to their personnel records they must seek them administratively 
in the first instance, using the established administrative process. 

You must not rely on the FOI process to handle requests made for access to documents which can be 
handled outside the FOI Act. There are several categories of documents which should be considered for 
release without a formal FOI application.  
As a general rule, the sorts of documents that are suitable for administrative release include those: 

• that relate to an individual 
• provided by an individual to the Department, which an individual would reasonably be expected to 

have access to 
• where the information involved would be released if it was requested under the FOI Act, either 

generally or to particular applicants whom the information concerns or affects 
• which are publicly available or can be made publicly available 

For example: documents which should be made available include service records, medical records, personnel 
file/records, fact finds (used to be referred to as Quick assessments) that involve the member and recruiting files. 
This list is not exhaustive and other documents containing personal information should also be considered. 

Administrative access will not be appropriate at all times. Where disclosure of the information sought would 
likely impact third parties, or would result in information from the documents being heavily redacted prior to 
disclosure, it may be more appropriate to deal with the request through the FOI process. 

Please note – FOI will not seek administrative release for documents such as: 
• Inquiry Officer Inquiries (IOI) – Defence Inquiries are only to be released in accordance with the 

Defence (Inquiry) Regulations, subsection 63(2). 
• Documents to which secrecy provisions apply – under section 38 of the FOI Act and inclusive of 

items listed in Schedule 3 of the FOI Act 

What should be considered when releasing documents 
outside the FOI Act? 

When releasing documents outside the FOI Act which also contain information other than that 
of the requesting individual you should prepare the document to comply with the Privacy Act 
1988. 

It is therefore necessary to point out to the applicant that the document should continue to be 
treated as official information and should not be released to the public. 

Further guidance relating to privacy matters can be located at: 

Web: http://drnet/People/ComplaintResolution/Pages/Complaints.aspx  

Email: defence.privacy@defence.gov.au 
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Further information 
Applicants seeking their personnel records are asked to provide written evidence to the FOI Directorate 
that they have attempted to seek the documents administratively in the first instance and any responses they 
have received from the actioning area. 

For applicants who agree to an administrative release, they must first withdraw their FOI request. This does 
not prevent or preclude the applicant from making any future valid FOI request. 

Requests for access to personnel records 
Members and former members of the ADF, or current and former employees of the Department, who wish to 
have access to their personnel records are prevented by section 15A of the FOI Act from applying under the 
Act unless they have first requested access through normal administrative channels. 

These may be their personal, health or psychology records.  

More information can be found here http://www.defence.gov.au/Records/ 

Accessing documents through the National Archives of 
Australia (NAA) 
Requests can be made to access Commonwealth archival records in the OPEN period (more than 20 – 30 years 
old). 

If the records sought were created by a Commonwealth Department or Agency and are more than 20 years 
old, a request to access them under the Archives Act 1983 (Cth) can be made by emailing ref@naa.gov.au 
or at the NAA webpage http://www.naa.gov.au/collection/askquestion/index.aspx 

Accessing documents through other related agencies 
The Department of Veterans Affairs – https://www.dva.gov.au/ 

The Australian War Memorial – https://www.awm.gov.au 

Links to legislation and guidance about FOI 
Office of the Australian Information Commissioner (OAIC) 

https://www.oaic.gov.au/freedom-of-information/ 

Freedom of Information Act 1982 (FOI Act) 
https://www.legislation.gov.au/Series/C2004A02562 

FOI Guidelines 
https://www.oaic.gov.au/freedom-of-information/foi-guidelines/ 

FOI contact details 
For further information please contact the FOI Directorate: 
Freedom of Information Directorate    
Campbell Park Offices 
Canberra ACT 2600 
 
Send an email to:  
FOI@defence.gov.au 
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On Sat, 2 Oct 2021 at 09:33,  wrote: 

OFFICIAL 

Dear  , 

  

Please find attached the decision and documents relating to Defence FOI 147/21/22. 

  
Rights of Review  

  

Under section 54 of the FOI Act, you are entitled to request a review of this decision. Your review rights are 
attached.  

  

Should you have any questions in regard to this matter please contact this office. 

  

Kind regards, 

  

 | Acting Director Freedom of Information  

Enterprise Transformation Branch | Enterprise Transformation and Governance Division | Department of Defence 
 Campbell Park Offices ACT 2600 

m   

  

http://www.defence.gov.au/FOI/privacy.asp 

  

IMPORTANT: This email remains the property of the Department of Defence. Unauthorised 
communication and dealing with the information in the email may be a serious criminal offence. If you 
have received this email in error, you are requested to contact the sender and delete the email immediately. 
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From:  on behalf of FOI Case Management
Sent: Wednesday, 6 October 2021 12:25 PM
To: CASG FOI
Subject: FOR ACTION: FOI Tasking - FOI 165/21/22 [SEC=OFFICIAL]
Attachments: Document Search Check List.docx; 02 FOI Determination - Schedule of 

Documents.doc; Statement of Reasons - Template.doc; S - FS - MIN Alert 
Processes for ADM.pdf; 00 Media and Sensitive Talking Points.docx

OFFICIAL 

Dear CASG 
 
This is a formal tasking relating to a request made on 2 October 2021, by   

 under the Freedom of Information Act 1982 (FOI Act) for: 
 
‘..access from Defence to the Commonwealth letter titled “Future Submarine Program ‐ Submarine Design 
Contract ‐ SFR Exit and Functional Baseline” (or similar title) dated 8 September 2021 (Objective ID: 
BM31956439). The document sought is the one listed as "Reference D" in the 15 September 2021 letter to 
Naval Group released to  on 2 October 2021 in Defence FOI Request 147/21/22.’ 

 
Action required 
 
Phase 1: Identify documents and appoint an ADM – due by 11 Oct 2021 

1. Acknowledge receipt of this request. 
2. Appoint an appropriate FOI Accredited Decision Maker (ADM) and advise the FOI Case Manager. Note: 

Please advise if there is a change to the appointed decision maker during the life of this request. 
3. Advise the FOI Case Manager of the name and contact details for the SES Band 1/1 Star subject matter 

expert for the topic of the request. 
4. Send the following to the FOI Case Manager: 

‐ The in‐scope documents in PDF form with no redactions  
‐ An electronically signed copy of the ‘search checklist’ (attached). 
‐ The Schedule of Documents (only required if there are five or more documents) 

 
Phase 2: Prepare draft documents – due by 18 Oct 2021 

1. Prepare and send the following to the FOI Case Manager: 
‐ Draft (unsigned) Statement of Reasons 
‐ Draft Schedule of Documents 
‐ PDF copy of the documents with proposed redactions marked with relevant redaction codes 

 
Phase 3: Final documents – due by 25 Oct 2021 

1. Prepare and send the following to the FOI Case Manager: 
‐ Finalised cleared Talking Points (if requested) 
‐ Signed Statement of Reasons (PDF version) 
‐ Documents in the form approved for release (with redactions applied by the ADM)  
‐ Schedule of Documents (if applicable) 

 
Consultation 
 
If the ADM identifies information that requires consultation with third parties, including foreign entities or State 
governments, please contact me for further guidance. It is important that this is identified early so that we can 
manage the available time appropriately. 
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If the ADM considers there is a requirement to liaise with the offices of the Minister, Secretary, CDF or VCDF, please 
advise as soon as possible—the FOI team will facilitate.  
 
Talking points and briefing support 
 
Talking points are required for all media and sensitive FOI requests. As this is a media request, additional 
information has been attached for your information. 
 
Timeframes 
 
Under the FOI Act, Defence has 30 calendar days to provide a decision and documents to the applicant. Failure to 
provide the documents to the appointed ADM in a timely manner will impact on the time they have available to 
make their decision. Documents and draft decisions must be reviewed by the FOI Directorate before they can be 
signed by the ADM. The timeline below provides a rough outline of what is required during the 30 days.  
 
Templates and examples 
 
Templates have been attached to this email for the Statement of Reasons (SOR), Schedule of Documents and 
Document Search Checklist. If you require assistance with drafting the SOR please contact the FOI Case Manager and 
we can provide sample wording for the ADM to consider.  
 
FOI Case Manager 
 
I am the Case Manager for this request and I am here to help you process this request. Please contact me early to 
discuss any questions or concerns. The best way to contact me is via email to: 
FOI.CaseManagement@defence.gov.au.  
 
Regards 
 

 | Case Manager Freedom of Information 
Enterprise Transformation Branch | Enterprise Transformation and Governance Division | Department of Defence 
a   Campbell Park Offices ACT 2600 
t    
FOI email: FOI.CaseManagement@defence.gov.au  
 

 
IMPORTANT: This email remains the property of the Department of Defence. Unauthorised communication and 
dealing with the information in the email may be a serious criminal offence. If you have received this email in error, 
you are requested to contact the sender and delete the email immediately. 
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From:  on behalf of FOI Case Management
Sent: Monday, 11 October 2021 8:54 PM
To:
Subject: Defence FOI 165/21/22 - Acknowledgement, due date and disclaimer 

[SEC=OFFICIAL]

OFFICIAL 

Dear   
 
I refer to your correspondence of 2 October 2021, in which you sought access under the Freedom of Information Act 
1982 (FOI Act) to the following documents:  
 

‘..the Commonwealth letter titled “Future Submarine Program ‐ Submarine Design Contract ‐ SFR Exit and 
Functional Baseline” (or similar title) dated 8 September 2021 (Objective ID: BM31956439). The document 
sought is the one listed as "Reference D" in the 15 September 2021 letter to Naval Group released to 

 on 2 October 2021 in Defence FOI Request 147/21/22.’ 
 
Please note that Defence does not release information that is considered ‘personal information’ of individuals other 
than the applicant; this includes private email addresses, signatures, personnel (PMKeyS) numbers and mobile 
telephone numbers, unless you specifically request such details. Defence excludes duplicates of documents and any 
documents sent to or from you. Furthermore, Defence only considers final versions of documents. If you are seeking 
personal details of other individuals, please advise this office by 13 October 2021 so that the decision maker can 
consider your request. 
 
Defence may impose a charge for the work involved in providing access to the documents in accordance with the 
Freedom of Information (Charges) Regulations. You will be notified separately if your request attracts a charge. 
Please note that there is no charge for documents that contain the personal information of the applicant. 
 
The statutory deadline for you to receive a response to your request is 1 November 2021. 
 
I am the Case Manager for this request. Should you have any questions relating to your request, please do not 
hesitate to contact me via email to FOI.CaseManagement@defence.gov.au. 
 
Regards 
 

 | Freedom of Information 
Department of Defence 
t  I e FOI.casemanagement@defence.gov.au  
 
 
 
 
IMPORTANT: This email remains the property of the Department of Defence. Unauthorised communication and 
dealing with the information in the email may be a serious criminal offence. If you have received this email in error, 
you are requested to contact the sender and delete the email immediately. 
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d. the Guidelines published by the Office of the Australian Information 
Commissioner under section 93A of the FOI Act (the Guidelines);  

e. advice received from officers from the Future Submarine Program: and  

f. consultation with Naval Group as a third party to the document.  

Reasons for decision   

Section 47 – Documents disclosing trade secrets or commercially valuable information  

7. Section 47(1)(b) of the FOI Act provides that a document is an exempt document if its 
disclosure under the FOI Act would disclose any other information having a 
commercial value that would be, or could reasonably be expected to be, destroyed or 
diminished if the information were disclosed.  

8. Subparagraph 47(1)(b) of the FOI Act states: 

(1) A document is an exempt document if its disclosure under this Act would 
disclose: 

…(b) any other information having a commercial value that would be, or 
could reasonably be expected to be, destroyed or diminished if the 
information were disclosed.  

9. The Guidelines state that to be exempt under s47(1)(b), a document must satisfy two 
criteria:  

(a) the document must contain information that has a commercial value 
either to an agency or to another person or body, and  

(b) the commercial value of the information would be, or could reasonably 
be expected to be, destroyed or diminished if it were disclosed.  

10. I found information in the document having commercial value to Naval Group. 
Disclosure of the commercial arrangements agreed between Naval Group and the 
Commonwealth could reasonably be expected to benefit Naval Group’s competitors in 
winning future work for which Naval Group is competing by revealing the terms that 
Naval Group is prepared to accept.  

Section 47G – Public interest conditional exemptions - business  

11. Upon examination of the documents, I identified the business information of Naval 
Group that if released, would, or could reasonably be expected to adversely affect Naval 
Group in respect of its business or professional affairs. 

12. Section 47G(1)(a) of the FOI Act states: 

(1) A document is conditionally exempt if its disclosure under this Act would 
disclose information concerning a person in respect of his or her business or 
professional affairs or concerning the business, commercial or financial affairs of 
an organisation or undertaking, in a case in which the disclosure of the 
information: 

(a) would, or could reasonably be expected to, unreasonably affect that 
person adversely in respect of his or her lawful business or professional 
affairs or that organisation or undertaking in respect of its lawful business, 
commercial or financial affairs. 

13. Disclosure of this information would, or could reasonably be expected to adversely 
affect Naval Group in respect of its business or professional affairs.  In light of the 
above, I have decided that the specified material identified is exempt under section 
47G(1)(a) of the FOI Act. 
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14. Section 11A(5) of the FOI Act requires an agency to allow access to an exempt 
document unless, in the circumstances, access to the document would, on balance, be 
contrary to the public interest. My public interest considerations are set out below. 

Section 47G – Public interest considerations 

15. In assessing whether disclosure is on balance, contrary to the public interest, I 
considered the Guidelines together with a range of factors set out in section 11B(3) [public 
interest exemptions-factors favouring access] of the FOI Act, which favours access to a 
document: 

(a) promote the objects of this Act (including all the matters set out in 
sections 3 and 3A); 

(b) inform debate on a matter of public importance; 

(c) promote effective oversight of public expenditure; 

(d) allow a person to access his or her own personal information. 

16. I note that disclosure of the requested information may promote some of the objects of 
the FOI Act. However, disclosure of the specific conditionally exempt material would not 
increase public participation in the Defence process, nor would it increase scrutiny or 
discussion of Defence activities. 

Further information

17. The document matching the terms of this FOI request contained protective handling 
markers. As the document is approved for release, these handling markers have been struck 
through.

Accredited Decision Maker 
Capability Acquisition and Sustainment Group 
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